PIX/ASA — {E FAASDMIR CLIF & Er 4B (R

B3

fE A7

N

o
H
i
=S

e
%

FERNAEHR
HE 2% 7= M
0
T e

{FH ASDM 5.x F 4% 55 4 ik £
/8 ASDM 5.x 4 ASDM R &
{5 ASDM 6.x F R k45 iR 15
/8 ASDM 6.x 4 ASDM R &

(=

RN B UMAER Cisco BEENZEIRZEES (ASDM) A4 Cisco ASA 5500 RINBENZ
®E LRSS,

MRFRERFZFHRUMN 7.0 EEARE 7.2 ( Sz @FELR ) S0 ASDM HRHEM 5.0 EZEALRE
52 (HixmER ) , Ml ASDM FEEM, ARFEREBIFIFHT,

ROl EHITM5.0BI5.289ASDMEEFH LR , BEEMS.0HERS.1, REMNSAHAEKEFS.2, B, 3t
FLZ2®E , BEMNTORRET71 , RENTAHRET.2,

& MBEMRE7A()ARIERFIRAT7.2(x) , RZTFA , MBARTHETR , BN IBREIHZ
SREMETER DI FHASDMIRE , MEF N T2 REMRET LR IHWASDMARG, EiF4 T ##
ARSRE |, FSH Cisco PIX Z2IRERITRAER 7.2(2) i@ A REFHTEAFRAZL S

AR : BTEEASA 5550 REIR T7.1Q2)MMHIRA, EH , EFEERFASA 5505/ K EK T
7208 RA . BXRIFMEE , FZHCisco ASA 5500F FIFIPIX 500 R 5 &2 £ iR Z B H 43
Ak,

AR EZBEREEXT , TEEFEAcopy titp flashis T AR ERFIEIERPHIPIX/ASARE ; {X1E
System Exec X T Xt #R4E,

ERFMH



//www.cisco.com/en/US/docs/security/pix/pix72/release/notes/pixrn722.html
//www.cisco.com/en/US/docs/security/pix/pix72/release/notes/pixrn722.html#wp43693
//www.cisco.com/en/US/docs/security/asa/compatibility/asamatrx.html

EX

AR EEABENER,

{5 FRY 4B #F
XN ERET AT REMBEARE :

. Cisco ASA 5500 7.0 R E & iR
. Cisco ASDM 5.0 & & 5 iR A

AXHEPNEERRETREXRENEFNRZEFEEN, AXEFEANMERZHNERAR
(BN ) BE, MREEANREIME  FRAREKELTHRMEG THEERN,

X~

B EE A5 Cisco PIX 500 RIIZEREMMRA 7.0 RESHRAEEER.

A

BRMHAENESZEER , 5% Cisco BARERAE,

TREHG

&R LAGE A AT 85 3 T R AT B RVASAR A IR FNASDMER A BR R hiR A

. Cisco ASARHIRA T H (AN EEMEF)
. Cisco ASDMERHRRAR T8 (X BEEME )
X : EMCisco.comTEMLEH , BFEEFERMNERAFEIL,

{5/ ASDM 5.x F & &k 4FmR

AT IXEELRR | LUER ASDM F4¢ ASA 5500 EEYER#HBR &

di

1. \ ASDM 9 =& O #F1i%&#8 Tools > Upgrade Software...o


//www.cisco.com/en/US/tech/tk801/tk36/technologies_tech_note09186a0080121ac5.shtml
//www.cisco.com/cisco/software/release.html?mdfid=279916854&flowid=4818&softwareid=280775065&release=8.4.4.1.ED&relind=AVAILABLE&rellifecycle=&reltype=latest
//tools.cisco.com/RPF/register/register.do
//www.cisco.com/cisco/software/release.html?mdfid=279916854&flowid=4818&softwareid=280775064&release=6.4.9&relind=AVAILABLE&rellifecycle=&reltype=latest
//tools.cisco.com/RPF/register/register.do

A% Cisco AS0M 532 for ASA - 172165521

Fie Oplionz | Tools ‘Virards Help S=mrch
© A Gommend Ling Intartace. ) i & r AR
Hiwivwe Parckal Tracer ... ack Farward Packed Tracer Redresh Save Help
Fingy
Oeyeee: Inf Tracarouls... Interface Status
Gonerdi | Fie Managemert. ortace | Pasdessetsk | Lee | Lk | kups
Hazt Mam Tk L Iw,,_ar nakde Er A=A g . 3 g
- -, . . nitskde 40030, 30 A0S e chamn i)
AEA Ver Uplasd S50 Assistart Guide... - 0d b S 4T =
System Reload
ASD Ve a8 ASA 5510
Firewal Mods Rousted Canted Mode: Single
Total Flash 64 MB Tekal bemory 268 MB Sxdecd an irderfacs 1o view nput snd cutpul Wbpe
VI'N Stafua Traffic States
KE Turiredz: ] VisbYRR Termel=: @ 5 Turnsts ] Conneobions Par Second Lsage

System Hesources Status

CFuU CFU Umage (percent]

Loe: 0 -0

‘oudside’ inderface Tratfic Usage (kbpe

Wi ng Memarg Uzspe (WD)

Irgput KEgs: I Ot BEgs:

2. NTHRBERERE FRNVREGRE,
] BR=o ]

Fla Cetione Toole  Vizerds Help S 2
g o = 5 - e Eisco Sretems
=0 % [ ¢ < & o ?
Home Corliguration Kanioring Erack Forward Packst Tracer Refrazh = ] Hedp
Device Infior roation Interface Stabus
Germrs |Li.;m| | Imterface | F Adoressflesk | Line | L | Hops |
e ASASEIRLOCTaLIT, AnnEn el | ] I fyl IR @ up 0w '
2 alsids 40,30, 3030025 @ down Woeom D
ASA Versk B Upgrade Software o x|
A%0N Wers

Firmal ko Uploed = file from loca comauder o flash file =y=tem on the device. The upload process mighl tske & Tewe minutss
Fleese wwart 10r 1he cpenation ba firkzh

Total Flasi:
VPl Siatus
KE Tunneis image to upkead: ) ﬂ
Syetem Rec Bplicstion Prafke Customizetion Fremswa (S8PCF)
S Lol File Pt ECH Erorevss Local Fies |
Clhenl Sacure Deskiop (S50
SEL WP Chent (S0
Flash Fie Syshem Fath Flsh filerame Broraves Flash... |
blema s

m e
FERdE

3. B3 Browse Local Files... 8% Local File Path FERP @ AKE , LUEEZHREMBEITHY
FHE,

4. % FBrowse Flash.... 5 HI Browse Flash Dialog 80 , EF B3 A THNMNXHBE
o MBRERXHE , BT File Name FERHAFIHMAZXHE. TREET OK,



]

Upload & tike from local compuier to flash file system on the denice. The upload process mght take & fevy minutes.

Flease wat for the operstion 1o finish.

Image to uplosd LA ll fink J
] 1
reni ()

Local File Patic - Documents and Settngs vidministratorDestdopPrabu P Birovecze Local Files...

Flazh File System Path: Flzsh fiename Brovwese Flash...

§% Browse Flash Dialog X
Folders Filez

e Flahiams - | sizetoytes) |  DateModfed |

asdm-520054 bin 5,002,580 12021 06 0 5830

A%AT 22-KE bin g,312,832 2007 06 05 0502

AB%A7 21-24-k8 bin 3,294 400 1 200706 D5 4720

asdm-521 bin 59,539,756 020 207 1418

asdm-522 bin 5523108 021207 O 2345

mEa702-kE bin 5,124,086 01 a0 103 O 06:22

pic 7 2 i B 750 544 12007 08 s 3450

P72 foin 8,202,240 1200706 051 9:40

= File Marme; i 722 hin|
= =0
5. BERMMTEN4HE G , £ Upload Image.

& Upgrade Software x|

Please wait for the operation fo finish.

Upload & file from lecal corguter to Nazh file system on the device, The wload process might 1ake & few mindes

Uplosd nmge |

Close | Help |

Fnage o upload: ASA ﬂ
Local File Path: CoDocuments and Settings A dministratorDesht oplPrakbu PG Browese Local Files...
Flash Flle System Path; ikl ki 722 bin

ASDM [ NFEE ARG BRI E R Status M,



f= Upgrade Software

Upload = file from local computer to flash file system on the device. The upload process might take a few minutes.
Pleasze wall for the operation 1o tlinish

Irnage to upload: Iﬂgﬂ E'

Local File Path:

| toe Locsi Fies. .

Pleaze wail while AS0M iz wuploading the file. Uplosd procezzs

miay take fews minules,
Flash File Systam P E Y st Flash...

N |

Closs Help

SERERE R Information BO }E/T\J:QZEJZIJJ

£= Upgrade Software : SR

Uplosd & file from local computes to flash file system on the device. The uplosd process might take & fevw mindes,
Please wal for the operstion to fiish,

Friage to upload: |-"-3P~ ll

Local File Path: |C:1D-:|-:umen1:9 and Settinggs A driniztr stor DesktopPrabutPl Browwze Local Files. ..

g% Information X

Flszh File Syztem Patir Brovese Flash...
@ AN mage = uploaded to flash successtuly,

Cloga Help E

6. £ Information B O ¥ &5 OK , AR5 ¥ 1 Upload Image from Local PC & 0 # Close,
7. 1% Configuration > Properties > Device Administration > Boot Image/Configuration > Edit

MEHE| SRE&AR.



Lonfguestion = Progeties = Dewce Administration = Boot Imad el onmguration

% Startup VWizard

! % B02 Sebup

Ant-Spaofing
w3 arp

a2l e Upsate

| Bioot ImegeCordiguration

Bact Canfiguration
Corfgure boot images oot sn extarnal TE TR garvar and fieeh fle 2ystem. U 1o fowr rages can be contiguresd
for ke Boot ystern Onby are TFTP baol imade can be configured. The TFTP baad image, if configured, must b

thie first i i the ket

—¢2\ Chiert Upoiata
w{E Cerificabe
¥l Device Acoess
=38 Devics Administration
— = Barmer
St Boot ImegeCont
—E8 L1 Prampt
O clock
2 Conzole
CESD Sebup
3 Davice
—aid FTP hioce
B TP Fules
) panagement Sec
TP
iRl PR snond

— % s=cure Copy

Bodl Image Lacstion

Ay

=

Defede

Bact Order

Felaies | e

[ (5%

Bioot Contig Fie Path: | E—

- ASDM Iminge Configuration
ASDN Image File Path

Erowese Flash, .

||:I:l-il:| fazdm-521 bin

al TFTF Server
il User Accouts —

# & Browse Flash Sz B RIS ASA B@STHE. /S % 8 OK.

CONNgurandn = FTOpermes = Davice ADmInISTanon = 8001 imagen onmgurainon

= Startup Yiizard » | 4-Boot ImageConfiguration
[+ A Selup ;
— L) Anb-Spooting g Euron
[ 'Ea ARP Configure boot images from an exdernal TFTP server and flash file system. Up bo four images can be configurd
| d e bl bmerd sk maee @edi 0 e TETTE b ol Do vars. o i [ S A iwmed Thes TE TN boued Iu.-tl " nmﬂw.mﬂ b
& RBrowse Flaxh Dialog _ﬁl
H
¥ Folderz Filz=z A
E
B o] Filehlame - | Sizeibvies) | DobeModified | e
a=dm-52054 hin G 002 B0 1272406 03:58:30
AEAT22-KE bin 8342832 1200706 05:09:02 Beiels
a7 21-24-k8 hin 8,294 400 1 20TIE D5:47:20
sadm-521 bin 5 530,756 02N 207 001 4:18 ot
seadm-522 kin 5 623,108 02A12007 D0:23:48 e
sz 02-kE.bin 5,124,056 MO0 03 0Dm0E:22
love Do
Browse Flash,
I
. Eroovze Flash...
[H
H Qi Cancel | Refresh |

8. i%4% File > Save Running Configuration to Flash , ABENEE#ER.



& Cisco ASDM 5.2 for ASA - 172.16.33.1

File Optionz Tools  Wizards Help

Fefresh ASDM with the BEunning Configuration on the Device H_,;' _1_{'{ G
-
Fezet Device to the Factory Default Configuration...
¥ 4 =T Packet Tracer Fefre

Showy Running Configuration in Mew Window ..

Save Running Configuration to Flash

Ionfiguration
Save Running Configuration to TFTR Server ...

Save Running Configuration to Standby Unit BT EIE

Afigure boot images from an externs
the boot =y=tem. Only one TFTR ba
first itmacge in the list.

Zave Internal Log Buffer ta Flash

Clear 250D Cache
Clear Internal Log Butfer

oot Crdder

disk: fpix 22 hin

Exit
=T Tarrer
E'E_g Boot ImagesiConfi
VF'IHII LI Pramgt
&) Clock

9. \E& O %$* Tools > System Reload , uiﬂﬁﬂﬂﬁ&%o _

§% Cisco ASDM 5.2 For ASA - 172.16.33.1 ST . B
Fie ©Owptionz Tools ‘Wizerds Help Search
pr =
f‘“_h Command Line Interface... ._,} _..-' -.-.l:"' G L._J ?
Houme e Ack Farward Packet Tracer Refrezh Save Hep
Ping...
Davice Ind Traceroute... Intertace Status
Gereral | Fie Managemert.. Wertsce | P Acgresstissk | Lie |
Hozt Mam Upgrade Softwara.. Ll inside 17216 T3ANE 1] up
ity Upioad ASDM Assistant Guide. . . SN outzica 40,2030 30026 @ down
ASOM e I E ASA 5510
Firewwal Woos: Roumed Contesxd Moms: Single
Total Flaze 64 Mi Total hiermory: 256 MB Select an intarface to view Input and output Kips
WPH Status Traffic Stalus
KE Turnels: ] WishvF Tunnels: 0 SWC Tunels: 0 LR e I

System Resources Stalus

CFU CFU Ugags (parcant)

Bl === e e e e e e s s e

UhE: 0 TR 0

04—+
004121 kRl 00 44 41 004601

'oulside' Intedface Trafic U=age (Kbpa)

g miany kamony Usage (WE)

Elkid

—|_'_|_|_|_|_|_|_|_|_|_'_|—
C0:4a:11 I SRy | 004441 o001

10 LR ER—NHEN E?Bﬂfl:i%ﬁbﬂikﬂ’]lﬂﬂﬂmw 1% Save the running com‘"guratlon
at the time of reload , R/FEFEFMBAVETE. Now — M BEVEFE 3R E . Delay By —
EEMNERZD SR P EEMMBRIREZ. Schedule at — 1B EF INEL R F A8 A A
Al RO EENMRITRINEFMERY , REREMIUEEFERME. 1£HF On
Reload failure, force an immediate reload after , REEERAREBME, XELZLREFEX




MREFEI S EENEMTFRENNE, 2FHATEG , FHTHRE (584 ) <HA/E
¥iEzh. %7 Schedule Reload.

@& System Reload

[%

Scheduks 8 sysiem relead or cancel 8 pending one.
Redoad Scheduling

Configuration State:

¥ Bave the running confcaration = fime of fl’.'il:lﬂlii

™ Reload without saving the running configuration
Reload Start Time:

= Pl

I Delay by by i oF e

" Schedule st b im I &y ;I ||_ j I..,,. j

Relcsd Message,
[ Onreload falure, farce an immediate reiosd after. | hk ; Frien oF FArm
Schadule Reload |
Fieload Stetus

ij Mo reload is scheduled.

Cancel Relosd J Refrezh | Dtz |

Last Updated 2M 207 1: 2637 PM

1. EF N HAE |, FE R Reload Status B0 , RALEEMITERME ., ERMAIBRE ASDM HY
®TL, EE : EASAEN M FHEIREHASDM,



@ Reload Status

Emllull AT T e = e B

£+

= ___ START GRACEFUL SHUTDCAT ---
Plaotification (24 207 1:31:26 P

E+4
[** - SHUTDOWI MOy -

Plotification (20 20F 1:31:27 P

£+
[** - SHUTDOW MO -

flotification (211207 1:31:27 PM):

%
[** === SHUTDHSAMR RO ---

Dan't showe this dialog again. To views reload status in the future, go to Toolz = System
Reload and click the Details buttan,

Refresh | Force mmediste Reload Exit A5

[4]

£ ASDM 5.x 74 ASDM BR{&

=

7o

BT XELSER , LUERA ASDM FA 4 ASA 5500 LHY ASDM BR &,

1. \ ASDM B9 E & O H % Tools > Upgrade Software...o



Syatem Resourees Status
CPL

CPU Usags (percenty

Fab i oy wimmony Liegs (B

Caomneotions Fer Segand Lsape

TR 0

& Cisco ASDM 5.2 for ASHA - 172,16.33.1 =10] x|
File Qpliong | Toos  ‘Wrards Help Sasrch Find =
P Comemid LI irhence ! 3 & Ciseo SwaTens
=l Paciel Tromom L) o =9, o ld a‘j
Hosnnee = =S ok Forward Pactet Tracer Refresh Save Help
Fing...
Deric-in ol e o Ilaacs Slatue
General File b arsagareit... bertace | P &rilresn sk | Line | Link K |
QUETRNY  Lperscks Sofboars... Iilltl Iz 1721633116 @ up L+ T ]
z cudsicie 40.30.30. 30128 @ down @m0
ASA e Uplane 8508 Assrtant Cuide i Bl @ity F0m 10
Syben Relaad .
AECM Ve = ASA S50
Firervwall Moce: Roaded Conbesd Mods Single
Tetal Flask E4 Ml Tobail M=rnory: 255 ML Zelecd animlerface o view rpul snd oo Kbps
WPH Sislu= Traffic Statws
IKE Turneks: ] Vet P Tumisks:. 0 S¥E Tumsks 0

MTos: 0

AT Wers
Firewell Mo
[otal Flasht

VPH Status

IKE Tunnieds Fnege bo uplead

System Res
CFU

Local Fike Path:

Flazh Flke System Path

ASA Yerak % Upgrade Software .

[~

Bppicabon Frofle Customizabon Framessark (APCF]
Appication Profie Cuslamization Framework (APCF)

ASA

el Khps: I O B,
2 NTHRXBEHERE FEINREGRE,
File Optonz Tools dizards  Help Search

- oo - 1 = =,
@ o5 1o O o N < ™

Honne: Configurstion fonioring Back Fotasard Packet Tracer Refrazh Save Help

Device Information Interface Status

Gemaral ] Licens= | Ftarface | F Acdreszblask | Ling
Host hleme ASAS50. default. domasininvalid ‘ e Tregs118 O up

nit=ics 40.230.30.20026 - [

Lipload & file trom local computer 10 Tash fle system on the device. The upload process mighl take & féw minutes
Pl wall Tor the operation 1o Tinsh.

Browse Local Fles, |

Cliernt S=cure Desiiap I:I-F'\'\.nl\l

=5l WP Qient [5Y0)

Flazh ficname

Liploed Image |

Brovyzs Flash... |

3. % i Browse Local... B Local File Path FERFREAER , LUIEE ASDM BMREITEN LB

fvil.

4. B HBrowse Flash.... FEEfFHIN Browse Flash Dialog B0 , Eb Bz A THMNNXHSB

o MBRERXHA

, 5% File Name FERPFHRA LXK B, TA/EET OKo




f= Upgrade Software x|

IUpkoad & file from ocal computer 1o flazh file 2ystem onthe device. The upload process might take a few minutes.

Plesse wail for the operation fo finish.

Image 1o uplosd: = =

Loz Fibe Path: |C ‘Docutnents snd Setbhgediministy st or'D e skiog Pr e/ Eroraeza Locel Files.. |

I& Browse Flash Dialog EI
Flesh File System Patft Iders Filas
B FileName | sizemvess | Date modities
asdm-52054 kin 6,002 530 12206 0358
asarZ2-kd hin B2 532 120706 0608
azarz]-24.k8 hin B,.294.400 120706 05 47
azdm-521 bin 5,558,756 029207 0014
azar02-k3 hin 5,124,096 01mim0s 0o os
ST TOTETT
File hiarne [ In:dm-SEE hin ]
jon lnnded successfuly.
0K Cancel Relfrazh |
= N
5. BEEARMMTEN4HE G , £ Upload Image.
% Upgrade Software x|

Uplzsd a file from local computer to flash file =ystem o the device. The uplssd process might take a few minutes .

Pleaze wal for the operation to finish.

image to upload: A S0 ﬂ

Local File Pati ChDocuments and SefingsAdminisirslonDeskiopieratbiuF Bronwrse Local Files.

Flash File System Patr dizki: fasdim-522 bin 1 Broswze Flazh,

Upload Image |

ASDM [ NZE ARG ErFE R Status B,




F% Upgrade Soltware Btk e s x|

Upload a file from Iocal compuler 1o fiash e ystem onthe device, The upload process might 1ake & few mindes
Flzaze wai for the operation to finish.

Ivesge o uplosd IPSDM ﬂ
Local Fie Pathc |C Dacumentz and SettingziAdminestradorDesidopiPrabutPl Brovevss Local Files. .
Flash Fie System Path |dﬁm:fasdm-522 i Browvse Flazh...

g% Status '::1. e ll

Pleage wil whils AZDM i3 uplosading the tie, Uplesd process

E may take few minubes.

. |

I T

SEREFE R Information O |, R EEHKI.
I= Upgrade Software - =

Lisinad a file from ocal complier 10 fissh fle 2ystem on the deyvice, The uplsad process might teee a Tew minues
Pleasze wail for the operation to finish.

Itage 1o upload: IP\SDM 3
[ imformation
Locsl Flis Path: L = Xl e LocaFies...
@ LS00 irmmpe is uploaded to flesh succeszfully.
Flazh File System Pathc Arasrse Flash,

6. £ Information B O H & &5 OK , AR ¥ & Upload Image from Local PC & 0 ##Y Close.
7. %% Configuration > Properties > Device Administration > Boot Image/Configuration , A

AR ASDM BRERTHE




ConmMguration = Fropeies = Device Administration = Baot ImagenConflguratan
[ Starug Vilzsrd | 4-Bact mgeiCormpuration
T% e ‘i_'g::sﬁqg Bant Candiguration
=% arm Carfigure boot issges from an exdermal TFTR sarver and flash fle sysbem, Up ba four images can be canfigured
-8 Auto pdee fiar 1he kool sy stern. Drily are TFTF bool imsge can b= configared, The TFTF baol imsge, if configurad, musl b=
L8 ciert _Im_'e £ firet Image i tha iz
w5 Cerlificate
= Device Access
=88 Device Administration
| =] Earirer Edit

Eoo Order Boot krage Location A

=3 U Promgd

_a Clack Dt

Console
— Ll CED s o L

—ﬂ FTF M wave Dawn
I8 |CWF Rudes
';!-H Maragernan Acc

— e : .
Bl Passward Boat Condig File Peth | Brovevze Flneh .

— ) Secure copy
SMTP .
E A500 Image Confipuration
D S =
TETP Server AZ0M lrage Fie Palkc
Lbear Accourls =

chskD: Ascm-521 bin

= Browse Flash Dialog X
Folders Filez
_m FileMame - Size (byles) Date Moddified
asdim-5 2034 bin 6,002 680 12021 6 035830
asa’ 22-ka bin 8,312 832 1207 06 080802
asar 21 -24-k5 bin §,294 400 120706 054720
asdm-521 bin 5,539,756 021 207 001 418

02A 207 02348

asar 02-kE bin 5,124 096 01 401 203 000622

B e e PN

Fila Mamea: mscim-522 bin

Ok Cancel | Fefresh |

8. i%#% File > Save Running Configuration to Flash , SAMB @ IN{FE M4 ERE.



& Cisco ASDM 5.2 for ASA - 172.16.33.1

File Optionz Tools  Wizards Help

Fefresh ASDM with the BEunning Configuration on the Device H_,;' J_r{'{ @
-
Fezet Device to the Factory Default Configuration...
¥ 4 weEr Packet Tracer Refre

Showy Running Configuration in Mew Window ..

Save Running Configuration to Flash

Ionfiguration
Save Running Configuration to TFTR Server ...

Save Running Configuration to Standby Unit BT EIE

Afigure boot images from an externs
the boot =y=tem. Only one TFTR ba
firzt image in the list.

Zave Internal Log Buffer ta Flash

Clear 250D Cache
Clear Internal Log Butfer

oot Crdder

diskl: fpix 7 22 hin

Exit
=T Tarrer
E}_g 31 Boot ImageiConfi
VF'IHII E¥) cLl Prompt
) Clock

9. \E& O %$* Tools > System Reload , uiﬂﬁﬂﬂﬁﬁﬁo

§ Cisco ASDM 5.2 for ASA - 172.16.33.1

File Opliors Tools Wierds Help Semrch:

[,:{:; Commmand Line kleriace... B _,I _J.T-:{ G L-_|] ?

Home St Iratan, bk Forsand Packet Trace: Refresh S Hedp

Firg...

Device I 1 anife Interface Status

Genera | e — Interfsce | P Addressiask [ Lhe |
Fiost flam  Uparads Softwsre i nzine 1721633116 Q up
T T —— outside 40 30,30 3026 @ down
Ao ve I ASA 5510
Fireweall Mode Routed Cortexd Mads: Single

Total Flask 4 MB Todal emary 266 MB Select eninterface fo view nput end output Kbps

VPH Salus TralTic Satus

KE Tunrels: ] Wieh'WPH Tunnedz: 0 SV Turneks: ]

Conneclions Per Fecand Uzage
E"'E"BITI Resources Stalus
CFU CPU Lkags (paicant)

] 1] l'.l -'I.'-= 01 o
ucP: 0 TCF. 0O M Totsl:
‘oukEide’ Infedace Tiatic Lags (Wb

Bl & m oy hlamary Lesge (MED

o1z oodigt | oniasd 004801 gt s M oundkbps
10. MR ER—NHED , ERVIEFEFHMFHFMEF S, £ Save the running configuration
at the time of reload , R/FEFEFMBAVETE. Now — M BEVEFE 3R E . Delay By —
EBEEMNRERZ Do/ EEFRMEREZ. Schedule at — I§TEEF N 1% %Z-#9 6 17
B, RATLEENRITRNEFRMREAK , RZF2ENIEEBEHRME, 1%EF On
Reload failure, force an immediate reload after , AEEERAREHE, XRLZSIREEX




MREFB S EBHMNEMTRENNE, EIUatEE , FRTRE (8F ) XA/E

¥iEzh. %7 Schedule Reload.

g% System Reload

Schedue & sysiem relosd or cancel 8 pending one,

Relzad Schaduling

Configuraion Siale;

(™ Relosd without sswving the running congurston

Reboad Start Tiene:

(% Mow
™ Delay by:

" Schedus st

Relad Message

hh - mm or mrm

P T | | T

[ On relosd feilre, force an irmediste reload after: | by - FREe OF e

Reload Status

i Mo relosd i schedded.

Schedule Relosd |

Cance! Relond | Refresh I Dietailz. . |

Las Upchatedd 20 207 1:28:57 FM

I

1. EFEHAE |, FE R Reload Status &0 , RAILEEMITERME ., ERMAIBRE ASDM HY
®TL, XX EASAEMNMEFHEIRE3HASDM,



B Reload Status |
lelullkarlarul T L= T I, ;I
* - START GRACEFUL SHUTDOWER —--

lotification (20207 1:31:26 Ph):

4]
[** === SHUTEZ T MO ---

Plotification (20207 1:351:27 PM:

*k
[** -—- SHUTEZ T B -

lotification (2207 1:31:27 Ph):

b+
[** === SHUTEZ T MO ---

L4]

Don't show this dialog again. To views reload status inthe future, goto Tools = System
Reload and click the Details button.

Refrezh Forze Immediste Relosd Exit LS00

{58 ASDM 6.x HEER4Emk

A : ASDM 6. xR FEASAFHF RGBS xR EGRA L F X,

SERUTIXSESE  LUEA ASDM A4 ASA 5500 +E9 SR

1. \ ASDM #9F & O #3%$2 Tools > Upgrade Software from Local Computer...o
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File View | Todls | Wizards  Window  Help

:l@ Hume|

Cammand Lime Interface...

Show Commands [gnored by A50M on Device

T
Home
B = Packet Tracer, ..
3 Devi 2
= Traceroute. ..
il e
s File Manaqgerment. . .
M| Uporade Software fromLocal Coputers.. |
I
A Upgrada Software from Csco.com. .. :]n -
Fil Syskem Reload...
T Administrators Alert bo Chentless S50 VPR Lsers. .,
— Preferences. .,
VPN | ASDM Java Console. ..
IKE: 0O IPzac: O Clientless 550 VPN O 251 PN Client: O
System Resources Stabus
—CPU—— —CPU Usage (percent)
10
0%, ;.
i

2 WIS iR E b8 A BGK,
g% Upgrade Software

Upload a file From local computer ko Flash File swstem on the device, The upload process might take a Few

minutes, Please wait for the operation ko finish,

Image ta Upload:

Local File Path:

application Profile Custamization Framewark, I:F'.F'CF]l;I

Flash File Swskem Path: [430M

Client Secure Deskkop (C50)
Cisco anyConneck WP Client

application Profile Customization Framewark (aPCF]

Upload Image Close

Help

Interface Status

Interface
DMz
inside
outside

Sedect an interface &

Tralfic Status

—Connections Per

12:08

WucF:-0 W

X

Browse Local Files, ..

Browse Flash. .,

3. & i Browse Local Files... % #E Local File Path FERFRRBARE , UEERZREMRBRE TR
LR, tbrhF 8318 ERE R Flash File System X #EE. MEKE R Flash File
System R XHIERE , ATAFEHEARRE , S¥ & Browse Flash , RiEEFHEE.



B= Upgrade Software - x|

(P

Upload a file From local computer to Flash file system on the device, The upload process might take a Few
minutes, Please wait for the operation to finish,

Image to Upload: I.ﬂ.S.ﬂ. ;I

Local File Path: |C:'|,F'rn:ugram Files\ Tftpdaztasad03-ka,bin i Browse Local Files..,

Flash File Sywstem Path: |di5kEl:,fasaBI33—kB.I:uin Brawise Flash. ..
Upload Image | Close | Help |

4. ARIEERMNXHERE , #iE Upload Image. ASDM [AFE ARG EEFE R Status
BEHo
% Upgrade Software 7 =

Upload a File B% Status ¥ EI Ie a fFew
minukes, Ple

Flease waik while 850M is uploading the file, The upload
Irmage ta L E process may kake a Few minukes.

Lacal File Pz &l Files. .,

Flash File 5 | ash, .,

5. WG , FFHM Information EA , IR EFHKI , HERFUHMRGZENS|ISREG, MRE
FFFTRRGAZ E 7 5| SR | WiEY%,nW B Noo

Image has been uploaded to Flash successfully, Do ol wank ko sef this image as
@ the boot image?

| Opload [made | L [n [ =] [

6. MREE Yes , NFHMBRIZE NG| SME , HSE R Information ., Click
OK.



= Information ,_ ; =

@ Your device configuration is updated ko use the new image.

To use this 454 image, the 454 needs to be reloaded, Go ko the menu ikemn, Tools
= Syskem Reload ko do this,

Be sure that you upgrade the A30DM image to one that is compatible with the new
A58 image,

Fie View | Tools | Wizards Window Help

I@] Home | 4 Command Line Inkerface. ., 0 Back \_) Forward | ) Help |
{ ]
: ey Show Cormimands Ignored by ASDM on Device =
Hnrm | e T T ETreTY
P Packat Tracer,,.
L ER
| PIl'II;I '
| Devi Interface Stat
Traceroute. .. e
el Interface
Fils Managarment, .. LMz
] Ipgrade Software from Local Compuker. .. inside
f5] : m 565 7
Upgrade Software from Cisco,com, .. ot side
B e
F”i mtﬂm Hehﬁlar
To Sdrrmnistrator’s dlert to Cientless 551 WP Usars. .,
Select an interfz
Preferences...
VPN | ASDM Java Consale. .. Traffic Status
IKE: O IPsec: 0 Clientlass 551 ¥PH; 0 S50 PN Client: 0 ~Connections
System Resources Status |

8. LI ER—NMHED , ERBIFEFH MBI FMES . 1£3F Save the running configuration at
the time of reload , A/FIEBREFH MK ATE, Now — MBEIEH B & %F . Delay By — iEE
MNAERSDO&HR/ P EEFIMNERE. Schedule at — IEEEF M RZ AR B K.
RAEEMRITVAERMELNK , RERELSAIENEFFEH MK, % On Reload
failure, force an immediate reload after , AFEERARIFNE, XRRZLREZFEXALEH
Bzl SFBEAEMTFRENRE, 2FMEEGE , FHTHRE (8 ) XA/EFB.

# & Schedule Reload.



9. ﬁﬂﬂiﬁ%ﬁl‘ﬂj , & R Reload Status BA , RAIEEEMITEN M. ERAIEH ASDM B
®I, B Exit ASDM , RAEEEMMBIREFEH B3 ASDM,



8% Reload Status

l\lu:utifin:atin:un (1/4/08 1:07:35 PMD:

A SHIITDOMWMN MOW -—

Potification (14105 1:07:35 PM):

btk

A - SHUTDOWH MOV ---

Potification (14108 1:07:35 PM):

thh

Ak SHUTDOWMN MOW -

Potification (1/4/05 1:07:35 PM):

i

A GHIITDOMWMN MOW —

Don't show this dialog again, To view reload status in the future, go to Tools = Syskem
Reload and click the Details button,

Refresh | Farce Immediate Reload Exit ASCiM

L]

£/ ASDM 6.x 7% ASDM BR{&

AR : ASDM 6.x{RIEASARHIRIRS xR BB RA L2 X #F

SERMATIXLESER |, LAER ASDM #H4 ASA 5500 LH) ASDM MR :

1. \ ASDM B9 F % O # %42 Tools > Upgrade Software from Local Computer...o
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File View | Todls | Wizards  Window  Help

Command Line Interface. .. i
:@ Hume| o Back, 0 Forward | ? Help|
— Show Commands [gnored by A50M on Device
Home
B = Packet Tracer, ..
i Devi 2 Interface Status
= Traceroute. ..
il 2e] Interface
s File Manaqgerment. . . oMz
M Upgrade Software from Local Computer... J Fiske
I :
5 Upgrade Software from Csco.com, .. :]n - autside
Fil Syskem Reload...
T Administrators Alert bo Chentless S50 VPR Lsers. .,
{aa R Sedact an inkerface &
¥PN | ASOM Java Cansole, .. Tralfic Status
IKE: 0O IPzac: O Clientless 550 VPN O 251 PN Client: O —Connections Per
System Resources Stabus
—CPU—— —CPU Usage (percent) o
10
12:08
08 - EuUDF: 0 M
. i i i :
2 NTHRXBEHFERE FEVREGRE,
B= Upgrade Software N x|

IIpload a File From local computer ba Flash file system on the device, The upload process might kake a Few
minukes, Please wait for the operation to finish.

Image to Upload: Application Profile Customization Framework, {AF‘CF}j
Local Eile Path: igillcatn:nn Prafile Customization Framework, (3PCF) e

Flash File System Path: Browise Flash. .

Zlient Secure Deskiop (C500
Zisco sy Conneck WP Client

Upload Image Close | Help |

3. # 5 Browse Local Files... 3 #E Local File Path FERHPEARE , LAfEE ASDM BMRTEITH
ML E, et B3 EME R Flash File System R X HHRE, MMEKEI R Flash File
System FHY AR , ATAFZHRARRE , &L Browse Flash , REEZERE,



#= Upgrade Software e x|

Upload a file from local computer to Flash File system on the device, The upload process might take a Few
minutes, Please wait for the operation to finish,

Image ko Upload: I.ﬂ.SDM ;I

Local File Path: |C:'|,F'rn:ugram Files\ TFtpdaztasdm-a03, bin i Browse Local Files.., i

Flash File Sywstem Path: ||:|i5kD:,|'asdm—EuI33.tnin Brawise Flash, ..
Upload Image | Close | Help |

4. ANEERNXHBRE , £F Upload Image. ASDM [E[N#FE AMEGH R EHFE R Status
&0,

Rl

Upload a Fil g% Status i x| Ie a few
minukes, Ple
Please wait while A50M is uploading the file, The upload

Image ko Uj E process may take a few minukes,

Local File P: al Files. ..

Flazh File 5 |- ash. .,

5. MG , FFHEM Information BO , IBREFHKI , HERFMIREGIZE N RIAK ASDM R &
o MREFFHMGZIZE N ASDM & , M2 Yes ; BN , #d5 Noo

Image has been uploaded ko Flash successfully, Do vou want ko sek this image as
@ the ASDM image?

| Opoad Imane | L [ [ HER I

6. BNRIEF Yes LAEAEFBREIER ASDM B& , NS HH Information . Click
OK.




E= Information

@ Your device configuration is updated ko use the new image.

To use this ASDM image, wou will need to exit and rerun to 850M, Click the Save

button inthe toolbar if wou wank to save this change in flash and make it
permanent,

7. BEHBE AL Save , AEFETPHERRFRNE.

ﬁ_'é Cisco ASDM 6.0 for ASA - 10.77.241.142

File Mieww Took ‘Wizards ‘Window Help
| : F
:@ Horme {% Configur akion El Maoritoring | [§

B - x : 1
-E _/% Device Dashboard I%Hrmll Cashboard |
E Device Information Interface Status
i iaeneral 1 |_i|:e|'|l_:|_=-,| Interface
[
Hiosk Mame:  CiscoASA.CISCO.COM _
|||'r5||:|e

8. AN HI — MR HE  BREMTHIN. Bk Apply.
E's&_ Save Running Configuration to Flash

X

apply i iZancel

9. B E OB File , R/F%#E Exit < ASDM,
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| Fle | view Took ‘Wizards Window Help

SE e —

Refresh AS0M with the Running Configur stion on the Device F5 b Back a Eorwisrd | ? Help |

Resek Device bo the Factory Default Configuration..

Shiows Running Configuration in Mew Window. ..

Save Running Configuration to Flash Crl+5
Save Running Configuration to TFTF Server, ..

Save Funning Configuration to Standby LUnit

Save Internal Log Buffer bo Flash

Ts
Print. .. Ctrl+P

Clear ASDM Cache
Clear Internal Log Buffer

¥PM Tunnels
IKE: O [Ps=c: O Clientless 550 ¥PN: 0 S50 PN Chent: 0

10. WA H I — X IEAE | EREH#ITHIN. BE
Exit ASDM -

@ Are wou sure yol want ko exit Cisco ASDM?
Click Yes to exit 850M or Mo ko continue using &50M,
v Blways display this dialog befare exiting From &30M,

] e |

€So

X

Interface Stat

Interface
DMEZE
inside
outside

Select an inbarfa

Traffic Status

—Connections

11. BIRiZ1T ASDM LAINE#FHY ASDM BR{&, BXFMAEE |, HSHMM . {aIERERE

ENZSIREEERASDM AR BRI BEN T 2IRE(ASA) LR BRE

HMFA BB ENZHEX |, TR NAIFEAASDMALKCisco ASA LR IR G : WAEABEH

ERREIRBEERASDMAREBR BENREIRE(ASA) LB ARG
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using Cisco Adaptive Security Device
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O e R SW W)

£/ CLI ARRHFMREH ASDM BRE

F R R BER ARG AT PIX/ASA B9 ASDM BMEEEMFEH TFTP RS 85, EifM 7 TFTP RS
BERVIERR | ESE TFTP RS SBHERNER,

£/ copy tftp flash @+ , AEAER TFTP FHM4MKR T RIS IENNEH, WEARLIZEZE
B &AL copy tftp flash 55 . FTTHMWBERE TREFME (EFE3 ) FHREHLELLIR
%o

LA 2 copy tftp flash @S £R M

copy tftp[:[[//location] [/tftp_pathnane]]] [[flash/diskO][:[inage | asdni]]
EE : WTFASA |, X B Fdisk0FFE #copydn 5 F Kflash,

NREAZGONRIEEMNERBERAESH , WSBEI—RFIFBE ( ELTF Cisco I0S®
RHARIE ) URE AN F BRI SENNHAE. MEABATE , N tftp-server @&
EPRISH. MERETHMALESH , NERAXLEERBEHENN thp-server R iRE. WRIZ
HTE—TESER ( MEEANLENEARE ), MSSESTRFARERAFEA.

NER IP#itREILZSIRZmRENVEET D IP it BEFH |, HarZilHE 28T name
names B EHTRARK, 22 REMVNTHNAMESIHEHREEINILNE, WEEHIP
address. route & RIP i S HBE, E4FEAB N MG SERTENEE.,

BRTYBRSHLXHNBRENRE S22/, BREFUUSEEMEREN. BEETHEELEE

. MREFEHELE TFTP HE%%%HEQF copy tftp flash @+ ARIXEKR B R , #Eﬁﬂ%ﬁ TFTP
BEFBREEAEANFTTEMRBHNRELHNER , IRABREEHZREN IP i RSB o
TFTP fREB(ERTT , HEEHREXREEREXHHRMRNE. AE , RSH[T TFTP BRET
HEZE2EE
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A RURHREL KR ASDM REFECAX LGS , TREHMEN , XEGTERLREENSIS
BR o

ASA#tcopy tftp [[flash:/disk0:] [software image name/asdm image name]]

!--- Command to set an image as bootup or specify the !--- ASDM image file. ASA(confi g) #boot
system [flash:/disk0:]/[software image name]

I--- Save active configuration to the Flash. ASA#twrite memory

I -——- Reboot the security appliance and load !--- with the new boot image as per the
configuration file. ASA#reload

A -

ASA5510#copy tftp diskO:

Address or nane of renote host []? 172.16.31.1

Source filenane []? asa722-k8. bin

Destination filenane [asa722-k8. bin]?

Accessing tftp://172.16.31.1/asa722-k8. bin... . trrrrrrrrrrrrrrrrrrrrrrrrrnnd
| I I I I A I I I A I I O A I O |

Witing file disk0:/asa722-k8. bin..
| I I I A I A I I O A I O |

8312832 bytes copied in 163.350 secs (50998 bytes/sec)

ASA5510#show diskO:

-#- --length-- ----- date/time------ path
6 5124096 Jan 01 2003 00: 06: 22 asa702-k8. bin
7 5623108 Feb 12 2007 00:23:48 asdm-522.bin
10 5539756 Feb 12 2007 00: 14: 18 asdm 521. bin
11 8294400 Dec 07 2006 05:47:20 asa721-24-k8.bin
12 6002680 Dec 21 2006 03:58:30 asdm 52034. bin
13 8312832 Feb 12 2007 22:46:30 asa722-k8.bin

23949312 bytes avail abl e (38932480 bytes used)

!--- Command to set "asa722-k8.bin" as the boot image. ASA5510(confi g)# boot system
disk0O:/asa722-k8.bin

!--- Command to set "asdm-522.bin" as the ASDM image. ASA5510(config)# asdm image disk0:/asdm-
522.bin

ASA5510# write memory

ASA5510# reload

AE  HEEHEMFTPIRSE 2FARASA LRI BREGRET | ATLAE A copy ftp flash@ T H R, HHH
ARFERIEESH , MBIPH U FFRX AR, LERBEUTTFTP, B2 , HP— N RHEIRELEE
SUERRIP/RED ( BTFTP—# ) ., ETFTPEXT , ATLUREUH T Atftp-serverin T8 E K%
W, 82 , FAFTPH , &AEXMER, RIAMBERT , REONMBL Routside , ZEOTEER.
BN, FTPARSS B8 R AT AR EBEE O /5 M)

iur
ERRBHBINRAFRRE R,

OHEARER (NEEMAS ) (OIT) XEFE L show 8. A OIT AIEEXS show S H
H 8 2o
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ASA EFing , BB RIIERNESEE ASDM 5§ , TURBIFEE EETHRENRE, BxIt
E8  FSHEEBE O LD General &I+,

B Chero A5T 5.7 foe ASA - 17216331 B =10 x|

Fie Oplich: Toolk ‘Wdzerds Hep Seanch Find -

:‘il _.i_’ :r _'J > -—'i‘f C“' lB ? Cisee Srsnems

HE;IIIEI Configuraion  Mondaring Sack Fiorward Packet Tracar Rafrezh Save Heks

[hemre: bk oar noesd icm Irtertace Stabus

Genernl | Licanse | Gl (e | P LcaessMash | L Link | ez |
Hinat M ASASSLdedfault. domain inalid neeide 1721633108 7 7 nin U

g ke &0, 30 30 300 7 ria ¥ nia A

INES Werzion 2t Device Lplime:

AEDM ¥ ersiorn 5.21) Dewice Type: A5 5510

Firerswall Mook Rioai el Corfla] Mook Sl

Tatal Flazn B4 MB Tolal remory: 266 MEB

WPH Satus Traffic Status

KE Turrels Wik PN Tunrels: SWVE Turrels:

Connections Fer Second Lrage

System Hesources Status

ZFLU CPU Lisage (perent)

une a TCFE 0 W Toeak O
"gulhds’ Inderacs Tramie Ueage ik bps)

Latest ASUM Syslog Messages

LTFCLIGA A TRIEAL :

1. Show version — & RASAG 37 #Y 2 BT AR &,
2. Show bootvar — & REFTINE G EFE ARG LR
3. Show asdm image — £ RASATE A # = BlasdmBR £,

TR P B B

B AR B H X L B SRR E R

HXER

- R4 RRE 4 TRINE | Cisco B2 BEHSTERER
- Cisco ASA 5500 RIIBEN R REF BRI

. Cisco HiERNZSREEFER "R

. Cisco PIX By R 384

. Cisco Secure PIX By Riifs 8%

. 47 & Field Notices ( 83& PIX)

- TFTP AR5 8RaYEF FfE A

- ZBNER PIX & B4

. WREME (RFC)

- ASA83IHER — REBETRHANE
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